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Copyright

Dieses Dokument unterliegt dem Copyright © 2010–2024. Die Beitragenden sind unten aufgeführt. 
Sie dürfen dieses Dokument unter den Bedingungen der GNU General Public License 
(http://www.gnu.org/licenses/gpl.html), Version 3 oder höher oder der Creative Commons Attributi-
on License (https://creativecommons.org/licenses/by/4.0/) Version 4.0 oder höher, verändern 
und/oder weitergeben.

Warennamen werden ohne Gewährleistung der freien Verwendbarkeit benutzt.

Fast alle Hardware- und Softwarebezeichnungen sowie weitere Stichworte und sonstige Angaben, 
die in diesem Buch verwendet werden, sind als eingetragene Marken geschützt.

Da es nicht möglich ist, in allen Fällen zeitnah zu ermitteln, ob ein Markenschutz besteht, wird das 
Symbol (R) in diesem Buch nicht verwendet.

Mitwirkende/Autoren

Michael Otto

Harald Berger

Jürgen Kirsten

Englisches Originaldokument

Dieses Kapitel wurde ursprünglich aus dem Englischen übersetzt und basiert auf dem
Chapter 2 - Entering and Editing Data. Autoren dieses Kapitels sind:

Steve Fanning

Olivier Hallot

Rückmeldung

Kommentare oder Vorschläge zu diesem Dokument können Sie in deutscher Sprache an die 
Adresse discuss@de.libreoffice.org senden.

Vorsicht

Alles, was an eine Mailingliste geschickt wird, inklusive der E-Mail-Adresse und 
anderer persönlicher Daten, die die E-Mail enthält, wird öffentlich archiviert und kann 
nicht gelöscht werden. Also, schreiben Sie bitte mit Bedacht!

Datum der Veröffentlichung und Softwareversion

Veröffentlicht am 21.04.2024. Basierend auf der LibreOffice Version 24.2.
Andere Versionen von LibreOffice können sich im Aussehen und der Funktion unterscheiden.
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Verwendung von LibreOffice unter macOS

Einige Tastenbelegungen und Menüeinträge unterscheiden sich zwischen der Macintosh-Version 
und denen für Windows- und Linux-Rechner. Die unten stehende Tabelle gibt Ihnen einige grund-
legende Hinweise dazu. Eine ausführlichere Aufstellung dazu finden Sie in der Hilfe der jeweiligen 
Komponente.

In Windows/Linux entspricht unter macOS Effekt
Menü
Extras > Optionen

LibreOffice > Einstellungen Zugriff auf die Programmoptionen

RECHTSKLICK

CTRL+KLICK und/oder 
RECHTSKLICK je nach 
Einstellungen

Öffnen eines Kontextmenüs

STRG (Steuerung) ⌘ (Command)
Tastenkürzel in Verbindung mit 
anderen Tasten

ALT ⌥ und/oder Alt oder Option
Tastenkürzel in Verbindung mit 
anderen Tasten

F11 ⌘+T
Öffnen der Formatvorlagen in der 
Seitenleiste

Synonyme

In diesem Dokument verwendete Synonyme:

für

Abschnitt

Deck

Dialogfeld, Dialogbox

Anfasser (Punkte am Ende einer Symbolleiste)

Menüleiste, Hauptmenü,

Register, Reiter

Tabulator

Objektpunkte (quadratisch, rund, oval)

in diesem Dokument verwendet

Bereich

Bereich

Dialog

Griff(e)

Menü

Tab

Tabulator

Ziehpunkte

Sie sehen vielleicht etwas anderes

LibreOffice läuft auf Windows, Linux, Mac OS X, FreeBSD und anderen Unix-Varianten, von 
denen jedes Betriebssystem unterschiedliche Versionen hat und kann von den Nutzern bezüglich 
Schriftarten, Farben und Themen angepasst werden.

Die Bilder in diesem Handbuch wurden mit hellem Thema in Ubuntu 20.04 erstellt. Das LibreOffice 
Thema entspricht der Werkseinstellungen.
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Einführung

Daten können in Calc auf verschiedene Art und Weise eingegeben 
werden: mit den Ziffern der Tastatur (Abbildung 2) oder im Ziffernblock 
(Abbildung 1), mit der Maus (drag and drop / ziehen und ablegen), mit 
dem Füll-Werkzeug oder mittels Auswahllisten.

In Calc ist es auch möglich, Informationen in mehreren Tabellen 
desselben Dokuments quasi gleichzeitig einzugeben.

Nach der Dateneingabe können Sie diese formatieren und/oder auf 
verschiedene Arten anzeigen.

Dateneingabe mit der Tastatur

Die meisten Daten werden in Calc wahrscheinlich mit der Tastatur bzw. dem Ziffernblock 
eingegeben.

Zahlen eingeben

Klicken Sie in eine Zelle und geben Sie eine Zahl mit den Ziffern-Tasten ein, entweder mit den 
Ziffern auf der Haupttastatur oder dem Ziffernblock. Im Ziffernblock muss dazu NUM-Lock einge-
schaltet sein.

Um eine negative Zahl einzugeben, schreiben Sie entweder ein Minuszeichen (–) davor oder 
schließen die Zahl in Klammern ein, z. B. (1234) und klicken die Schaltfläche Übernehmen  
oder drücken die EINGABETASTE.

Standardmäßig sind Zahlen nach rechts ausgerichtet und negative Zahlen haben ein führendes 
Minus Symbol. 

Wenn eine Zahl im Format 01481 eingegeben wird, zeigt Calc die führende 0 nicht an. Dies kann 
aber durch eine entsprechende Formatierung der Zelle erreicht werden. (Siehe Tipp).

Tipp

Damit eine Zahl mit einer führenden Null angezeigt wird, muss die Zelle entsprechend 
formatiert werden. Klicken Sie mit der rechten Maustaste auf die Zelle und wählen 
Zellen formatieren, im Dialog Zellen formatieren den Tab Zahlen. Unter Optionen bei 
Führende Nullen sollte in diesem Beispiel eine 5 gewählt werden für die Anzeige von 
01481. Der gespeicherte Wert ist dabei jedoch trotzdem die Zahl 1481. Der Wert 481 
wird mit fünf führenden Nullen als 00481 angezeigt.

Text eingeben

Klicken Sie in die Zelle und tippen Sie ihren Text ein. 

Der Text ist standardmäßig linksbündig. Zellen können mehrere Textzeilen enthalten. Wenn Sie 
Absätze verwenden möchten, drücken Sie Strg+Eingabe, um einen weiteren Absatz zu erstellen.
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Abbildung 2: Ziffern der Tastatur

Abbildung 1: Ziffern des 
Ziffernblocks



Zahlen als Text eingeben

Zahlen können auch als Text eingegeben werden. Dadurch kann zum Beispiel für Telefonvorwah-
len auch eine führende Null angezeigt werden. Um eine Zahl als Text zu definieren, geben Sie vor 
der Zahl ein einfaches Anführungszeichen wie folgt ein: ’01481. 

Die Ziffern werden jetzt als Text behandelt und in der Zelle linksbündig angezeigt.

Üblicherweise werden Formeln sowie einige Funktionen versuchen, die als Text formatierten 
Ziffern in eine Zahl zu konvertieren, um die Berechnung durchzuführen. Dieses Verhalten kann in 
Extras ► Optionen ► LibreOffice Calc ► Formel unter Detaillierte Einstellungen für Berech-
nungen mit Angepasst und Details durch Konvertierung von Text in eine Zahl angepasst werden.

Hinweis

Wenn ein einfaches Anführungszeichen (Apostroph) benutzt wird, um ein führende 0 
in der Zelle anzuzeigen, ist das Anführungszeichen in der Zelle nach dem Drücken der 
Eingabetaste nicht sichtbar. Wenn typografische Anführungszeichen („“) benutzt 
werden, bleibt das Anführungszeichen in der Zelle sichtbar.

Um diese Art von Anführungszeichen zu wählen, verwenden Sie Extras ► AutoKor-
rektur-Optionen ► Gebietsschemaabhängige Optionen. Machen Sie bei Ersetzen 
für das jeweilige Anführungszeichen ein Häkchen, um diese Funktion zu aktivieren. 
Diese Auswahl für das Anführungszeichen gilt sowohl für Calc als auch für Writer.

Datum und Uhrzeit eingeben

Datum

Geben Sie einfach in der gewünschten Zelle das Datum ein, z. B. 13.04.2024 oder 10. Oktober 23. 
Calc kann eine Vielfalt von Datumsformaten darstellen, siehe Abbildung 3.

Uhrzeit

Geben Sie einfach in der gewünschten Zelle die Uhrzeit ein. Sie können die 
Uhrzeitelemente (‚Stunden:Minuten:Sekunden‘) mit Doppelpunkten getrennt, 
wie beispielsweise 10:43:45 eingeben. Auch hier stehen diverse Uhrzeitfor-
mate zur Verfügung, siehe Abbildung 4.
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Abbildung 4: 
Formate für Uhrzeit

Abbildung 3: Formate für Datum



Sonderzeichen eingeben

Sonderzeichen sind Schriftzeichen, die weder Buchstabe noch Ziffer sind und größtenteils auf 
einer Tastatur nicht vorhanden sind. Beispiele sind: © ¾ æ ç ñ ö ø ¢.

Um ein Sonderzeichen einzufügen:

• Platzieren Sie die 
Schreibmarke in die 
Zelle, in der Sie das 
Zeichen erscheinen 
lassen möchten.

• Klicken Sie auf Einfü-
gen ► Sonderzei-
chen, um den Dialog 
Sonderzeichen zu 
öffnen (Abbildung 5).

• Klicken Sie auf das 
Zeichen (von einer 
beliebigen Schriftart), 
das Sie einfügen 
möchten. Das zuletzt 
gewählte Zeichen, 
wird rechts angezeigt, zusammen mit dem dezimalen und hexadezimalen Code für dieses 
Zeichen. Wenn Sie das gewünschte Zeichen ausgewählt haben, klicken Sie auf Einfügen  
und schließlich die Schaltfläche Übernehmen  oder drücken Sie die EINGABETASTE.

Hinweis

Jede Schriftart kann andere Sonderzeichen enthalten. Wenn Sie ein bestimmtes 
Sonderzeichen nicht finden, ändern Sie die Schriftart.

Das Einfügen von Gedankenstrichen

Um einen Gedankenstrich (Halbgeviertstrich, „en dash“) und einen Spiegelstrich (Geviertstrich, 
„em dash“) einzugeben, setzen Sie, z. B. zwei Bindestriche, die nach Drücken der EINGABETASTE 
zum Gedankenstrich gewandelt werden (siehe Tabelle hier unten). Damit diese Umwandlung 
vollzogen wird, setzen Sie mit Extras ► AutoKorrektur-Optionen im Tab Optionen ein Häkchen 
bei Gedankenstriche ersetzen.

In der folgenden Tabelle stellen A und B die Platzhalter, z. B. für die Buchstaben A bis z dar, oder 
bei der Angabe z. B. „G – w“ oder bei Ziffern von 0 bis 9 „0 – 9“.

Text den Sie eingeben: Resultat:

A␣– B␣ (A Leerzeichen Bindestrich Leerzeichen B) A –␣ ␣B (A Leerzeichen Gedankenstrich „en“ 
Leerzeichen B)

A --␣ ␣B (A Leerzeichen Bindestrich Bindestrich 
Leerzeichen B)

A␣– B␣ (A Leerzeichen Gedankenstrich „en“ 
Leerzeichen B)

A--B (A Bindestrich Bindestrich B) A—B (A Spiegelstrich „em“ B)

A-B (A Bindestrich B) A-B (unverändert)

A␣-B (A Leerzeichen Bindestrich B) A␣-B (unverändert)

A␣--B (A Leerzeichen Bindestrich Bindestrich B) A␣–B (A Leerzeichen Gedankenstrich „en“ B)
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Abbildung 5: Dialog Sonderzeichen



Deaktivieren automatischer Änderungen

Bei der Dateneingabe erfolgen viele Änderungen automatisch. Dieser Automatismus kann indivi-
duell deaktiviert werden. Unabhängig davon können Sie auch automatische Änderungen mit 
STRG+Z sofort rückgängig machen.

AutoKorrektur

Unter Extras ► AutoKorrektur 
im Tab Optionen kann die 
automatische Korrektur von 
Eingabefehlern, die Ersetzung 
von geraden Anführungs-
zeichen durch typografische 
Anführungszeichen (benutzer-
definiert) oder die Großschrei-
bung des ersten Buchstabens 
eines Textes eingestellt werden. 
Deaktivieren Sie Kontroll-
kästchen, um nicht erwünschte 
Eigenschaften zu deaktivieren.

Im Tab Ersetzungen können Sie 
auch unerwünschte Wortpaare 
löschen oder Sie fügen Neue 
nach Ihrem Wunsch hinzu.

AutoEingabe

Wenn Sie in einer Zelle etwas eingeben, schlägt Calc automatisch eine passende Eingabe vor, die 
in derselben Spalte vorhanden ist. Um die AutoEingabe ein- oder auszuschalten, setzen oder 
entfernen Sie das Häkchen vor Extras ► AutoEingabe, indem Sie darauf klicken.

Automatische Datumsumwandlung

Calc wandelt bestimmte Einträge automatisch in ein Datumsformat um. Geben Sie deshalb am 
Anfang des Eintrags ein einfaches Anführungszeichen ein, um sicherzustellen, dass der Eintrag 
als Text erhalten bleibt. Das einfache Anführungszeichen wird in der Zelle nicht angezeigt.

Dateneingabe beschleunigen

Die Dateneingabe in einer Tabellenkalkulation kann sehr arbeitsintensiv sein. Calc bietet mehrere 
Extras zur Vermeidung einiger eher stumpfsinniger Eingabe-Arbeiten an.

Die grundlegendste Fähigkeit ist, die Inhalte von einer Zelle zu einer anderen, mit einer Maus zu 
ziehen und fallen zu lassen. Viele Nutzer finden auch die AutoEingabe nützlich. Calc enthält auch 
mehrere andere Werkzeuge für die Automatisierung der Eingabe - insbesondere für sich immer 
wiederholenden Aktivitäten. Dies sind z. B. das Füll-Werkzeug, die Auswahllisten und die Fähig-
keit, Informationen in mehreren Tabellen desselben Dokuments einzugeben.
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Abbildung 6: Dialog AutoKorrektur



Verwendung des Füll-Werkzeugs

In seiner einfachsten Form ist das Füll-
Werkzeug eine Möglichkeit, einen bereits 
vorhandenen Inhalt zu duplizieren.

Als ersten Schritt wählen Sie die Zelle, 
die den zu kopierenden Inhalt enthält. 
Ziehen Sie dann die Maus, z. B. nach 

unten (oder Sie halten die UMSCHALT-Taste gedrückt und 
klicken in die letzte Zelle, die Sie füllen wollen). Die Zellen 
sind dann blau markiert. Als letzten Schritt wählen Sie 
Tabelle ► Zellen ausfüllen (Abbildung 7) und die 
Richtung, in unserem Beispiel Nach unten aus.

Der Inhalt der zuerst ausgewählten Zelle wird in die 
anderen Zellen hineinkopiert, siehe Abbildung 8.

Vorsicht

Auswahlkriterien, die nicht verfügbar sind, sind ausgegraut. Aber Sie können noch aus 
Versehen die entgegengesetzte Richtung auswählen. Dies könnte dazu führen, dass 
dort Zellen überschrieben würden.

Tipp

Ein kürzerer Weg die Zellen zu füllen ist 
der, das kleine Quadrat in der rechten 
unteren Ecke einer Zelle zu ergreifen und 
es in die von Ihnen gewünschte Richtung 
zu ziehen, um die Zellen auszufüllen. Wenn 
die Zelle eine Zahl oder eine Kombination 
von Text mit einer Zahl enthält, werden die 
Zahlen in den Zellen je nach Ziehrichtung 
serienweise erhöht bzw. erniedrigt ausgefüllt, Abbildung 9. Um stattdessen die Zahl 
oder den Text zu duplizieren, halten Sie beim Ziehen die STRG-Taste gedrückt. Wenn 
die Zelle nur Text enthält, wird der gleiche Text in die Richtung gefüllt, die Sie ausge-
wählt haben.

Wenn Sie beginnend von einer Zelle nach unten ausfüllen möchten und die Zelle 
einen benachbarten Bereich hat, der ebenfalls Daten enthält, kann das Ausfüllen mit 
Doppelklick auf das kleine Quadrat schnell ausgeführt werden. Das Ausfüllen wird so 
weit nach unten fortgeführt, solange Daten im Nachbarbereich vorhanden sind.

Wenn Sie beim Verwenden des Füll-Werkzeugs bzw. des kleinen Quadrates mehrere 
Zellen markiert haben, wird Calc versuchen ein Muster bei Ihren Daten zu finden, um 
das Ausfüllen mit dem gleichen Muster fortzuführen. 
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Abbildung 7: Menü Zellen ausfüllen

Abbildung 8: Zellen ausfüllen Nach unten

Abbildung 9: Zellen ausfüllen durch Ziehen



Verwendung einer Ausfüll-Reihe

Eine komplexere Verwendung des Füll-Werk-
zeuges ist es, eine Ausfüll-Reihe zu verwenden. 
Calc hat vorbereitete Listen für die vollen und 
verkürzten Wochentage und Monate eines Jahres. 
Sie können aber auch Ihre eigenen Listen 
erstellen.

Um eine Reihe zu füllen, wählen Sie die Zellen 
aus, die gefüllt werden sollen. Klicken Sie dann auf 
Tabelle ► Zellen ausfüllen ► Mit Reihen. Im 
Dialog Reihen füllen klicken Sie bei Reihentyp auf 
Automatisch füllen und geben Sie als Startwert 
z. B. Januar ein (Abbildung 10).

Die zuvor ausgewählten Zellen werden dann mit den Folgemonaten ausgefüllt. Wurden vorher 
mehr als 12 Zellen ausgewählt, beginnt das Ausfüllen bei Zelle 13 erneut mit Januar.

Bei der Verwendung einer Ausfüll-Reihe wird nur eine temporäre Verbindung zwischen den 
markierten Zellen hergestellt. Sobald die Zellen ausgefüllt sind, haben die Zellen untereinander 
keine weitere Verbindung mehr.

Definieren einer Ausfüll-Reihe

Um Ihre eigene Ausfüll-Reihe zu definieren, gehen Sie zu Extras ► Optionen ► LibreOffice 
Calc ► Sortierlisten. Dieser Dialog zeigt die vordefinierten Reihen links in dem Feld Listen und 
die Einträge der markierten Liste.

Klicken Sie auf Neu . Das Feld 
Einträge ist nun ohne Inhalt. 
Schreiben Sie eine Ausfüll-
Reihe für eine neue Liste in 
das Feld Einträge. Sie können 
z. B. die Monate mit nur einem 
Buchstaben abkürzen 
(J,F,M,A,M,J,J,A,S,O,N,D). 
Schreiben Sie die einzelnen 
Einträge jeweils in eine Zeile 
und klicken Sie dann auf 
Hinzufügen  (Abbildung 11).

Alternativ können Sie vorab in einer Tabelle in einer Spalte untereinander die 
jeweiligen Einträge eingeben, dann markieren Sie diese Felder, rufen den Dialog 
Sortierlisten auf und klicken unten auf die Schaltfläche Kopieren .

Verwendung von Auswahllisten

Die Auswahllisten-Funktion in Calc vervollständigt Einträge automatisch durch 
Text, der bereits in derselben Spalte vorhanden ist. Auswahllisten sind nur für 
Texteingaben verfügbar. 

Um eine Auswahlliste zu verwenden, wählen Sie eine leere Zelle aus. Rufen Sie 
mithilfe der rechten Maustaste das Kontextmenü auf und wählen Auswahlliste 
aus oder verwenden die Tastenkombination ALT + CURSORTASTE NACH UNTEN. Ein 
Auswahlmenü erscheint, die den zur Auswahl stehenden Text enthält (Abbildung 12). 
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Abbildung 10: Zellen ausfüllen - Reihen füllen

Abbildung 11: Sortierlisten - Hinzufügen

Abbildung 12: 
Auswahlliste



Die Texte sind alphabetisch geordnet. Mehrfache Einträge kommen in der Liste nur einmal vor. 
Klicken Sie auf den Eintrag in der Liste, den Sie in die aktuelle Zelle kopieren möchten.

Dateneingabe für mehrere Tabellen verwenden

Es ist auch möglich, eine Dateneingabe für mehrere Tabellen auszuführen. Anstatt die Daten auf 
jeder Tabelle individuell einzugeben, können Sie die Dateneingabe, Ausfüll-Reihe oder Auswahllis-
te in einem Schritt für mehrere Tabellen an der gleichen Stelle eingeben. Um dies zu tun, klicken 
Sie mit der rechten Maustaste unten auf die Tabellen-Leiste (also unten den Tab, z. B. Tabelle1) 
und wählen im Kontextmenü Alle Tabellen oder mit UMSCHALT+KLICK weitere Tabellen hinzu. 
Alternativ können Sie auch im Menü Bearbeiten ► Auswählen ► Tabellen mit UMSCHALT+KLICK 
die gewünschten Tabellen auswählen. Nun können Sie Text eingeben oder automatisch ausfüllen. 
Diese Dateneingabe wird dann in den ausgewählten Tabellen ausgeführt, das Erhöhen bzw. 
Erniedrigen von Zahlen wird dabei in jeder Tabelle individuell ausgeführt.

Vorsicht

Diese Technik überschreibt – ohne Warnung – alle Informationen, die bereits in den 
Zellen der ausgewählten Tabellen stehen. 
Wenn Sie fertig sind, sollten Sie unbedingt alle Tabellen abwählen, außer der einen, 
die Sie weiter bearbeiten wollen. Klicken Sie auf eine nicht markierte Tabelle, um eine 
mehrfache Auswahl abzuwählen.

Zelleninhalt automatisch überprüfen lassen (Gültigkeit)

Bei der Eingabe von Daten in Tabellen können Sie 
automatisch überprüfen lassen, ob die eingegebenen Daten 
bestimmten Kriterien entsprechen – z. B. können Sie 
überprüfen lassen, ob ein Zahlenwert über Null oder ein Text 
mit mindestens vier Buchstaben eingegeben worden ist oder 
ob eine Zelle nicht leer gelassen werden darf. Diese Funktio-
nalität stellt somit eine Art Plausibilitätsprüfung dar.

Um neu eingegebene Daten überprüfen zu lassen, wählen 
Sie zunächst die Zellen aus, in denen später die Datenein-
gaben überprüft werden sollen. Wählen Sie nun unter Daten 
► Gültigkeit den Dialog Gültigkeit. Dort kann die Art der 
Inhalte, die in dieser Zelle eingegeben werden können, 
ausgewählt werden (Abbildung 13).

Sie können neben der Art der Gültigkeit auch Eingabehilfen und/oder Fehlermeldungen definieren. 
Eingabehilfen erklären die Inhaltsregeln, die Sie für die Zelle eingerichtet haben und was der 
Benutzer tun sollte, wenn er einen falschen Inhalt eingeben hat. Mittels Fehlermeldungen können 
Sie festlegen, ob der fehlerhaft eingegebene Zelleninhalt übernommen oder verworfen werden 
soll. Es ist sogar möglich, bei einem Fehler ein Makro zu starten.

Die Gültigkeitsüberprüfung ist für Zellen mit Funktionen sehr nützlich. Wenn Sie es erlaubt haben, 
dass ungültige Zellinhalte eingegeben werden dürfen, können Sie unter Extras ► Detektiv ► 
Ungültige Daten einkreisen wählen, um diese Zellinhalte zu finden. Die Detektivfunktion markiert 
alle Zellen mit ungültigen Daten durch einen Kreis.
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Abbildung 13: Dialog Gültigkeit



Beachten Sie, dass eine Gültigkeits-Regel 
eine Zellenformatierung darstellt. Wenn Sie 
Zellen formatieren oder Tabelle ► Inhalte 
löschen wählen, dann wird die Gültigkeits-
Regel ebenfalls entfernt. Dies führt auch 
dazu, dass das Wiederholen der Detektiv-
funktion Ungültige Daten einkreisen die 
bisherigen, als ungültig gekennzeichneten 
Datenkreise entfernt, weil die Daten nicht 
mehr weiterhin ungültig sind. Abbildung 14 
zeigt die Auswahlmöglichkeiten für eine 
typische Gültigkeitsprüfung.

Kriterien und Prüfungsoptionen

Die Prüfungsoptionen für die Gültigkeit, variieren mit der Angabe, die im Tab Kriteri-
en bei Zulassen ausgewählt wurde. Abbildung 14 zeigt als Beispiel die Auswahl-
möglichkeiten, wenn für eine Zelle ein Zellbereich vorgegeben wird. Beachten Sie 
die Option Leere Zellen zulassen. Damit kann in unserem Beispiel auch die Zelle 
A5 leer gelassen werden (siehe Abbildung 15), ohne dass durch den Detektiv 
ungültige Daten gekennzeichnet werden.

Eingabehilfe

Um die Eingabehilfe für eine Zelle zur Verfügung zu 
stellen, verwenden Sie den Tab Eingabehilfe im Dialog 
Gültigkeit (Abbildung 16).

Bei der Dateneingabe 
wird dann ein Feld mit 
Titel und Hilfetext ange-
zeigt (Abbildung 17).

Fehlermeldung

Um eine Fehlermeldung anzuzeigen, wenn 
ein ungültiger Wert eingegeben worden ist, 
verwenden Sie den Tab Fehlermeldung, 
Abbildung 18.

Bei der Daten-
eingabe ungül-
tiger Werte 
wird dann eine 
Fehlermeldung 
mit Titel und 
Hilfetext angezeigt (Abbildung 19).

Als Fehlermeldung sollte ein aussagekräftiger Text bzw. ein Hinweis auf zulässige Daten einge-
stellt werden, z. B. Zahl muss >12 sein.
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Abbildung 16: Gültigkeit EingabehilfeAbbildung 17: Titel und Hilfetext

Abbildung 18: Gültigkeit FehlermeldungAbbildung 19: Fehlermeldung

Abbildung 15: 
Quelle

Abbildung 14: Gültigkeit Kriterien Zellbereich



Bearbeitung von Daten

Die Bearbeitung von Daten kann auf vielfältige Art und Weise erfolgen. Der erste Schritt ist die 
Zelle auszuwählen, in der etwas eingetragen bzw. bearbeitet werden soll.

Entfernen von Daten aus einer Zelle

Daten können auf unterschiedlicher Art und Weise in einer Zelle entfernt werden. Mit Entfernen ist 
das Löschen von Daten gemeint.

Nur Daten entfernen

Daten können in einer Zelle entfernt werden, ohne dass die Formatierung der jeweiligen Zelle 
entfernt wird: klicken Sie auf die Zelle, um sie auszuwählen, und drücken Sie die ENTF-Taste.

Entfernen von Daten und Formatierung

Daten in Zellen können auch gleichzeitig mit der Formatierung 
entfernt werden. Dazu 

• machen Sie einen RECHTSKLICK mit der Maus auf die 
Zelle und wählen Zellinhalte löschen aus, 

• drücken die RÜCKTASTE oder 
• benutzen Tabelle ► Inhalte löschen, 

um den Dialog Inhalte löschen zu öffnen, Abbildung 20. In 
diesem Dialog können verschiedene Inhalte der Zelle zum 
Löschen ausgewählt werden. Um alles in einer Zelle zu 
löschen (Inhalt, Formate etc.), aktivieren Sie Alles löschen.

Ersetzen aller Daten in einer Zelle

Um Daten zu entfernen und neue Daten einzufügen, überschreiben Sie einfach die Daten in der 
jeweiligen Zelle. Die neuen Daten werden die ursprüngliche Formatierung erhalten.

Teile der Daten in einer Zelle ändern

Manchmal ist es notwendig, nur einen Teil der Zellinhalte zu ändern – zum Beispiel wenn Sie 
einen längeren Text ändern wollen. Es ist manchmal praktischer, nur die Änderung durchzuführen 
und nicht den gesamten Zelleninhalt zu löschen und dann den neuen Inhalt einzutragen bzw. zu 
überschreiben. Eine Änderung des Zellinhaltes ist auf zwei Wegen möglich.

Mit der Tastatur

Nach der Auswahl der Zelle, in der die Änderung durchgeführt werden soll, drücken Sie die F2-
Taste. Dadurch wird die Schreibmarke am rechten Rand des Zellinhalts platziert. Verwenden Sie 
nun die Richtungspfeil-Tasten der Tastatur, um die Schreibmarke durch den Text in der Zelle zu 
bewegen.

Mit der Maus

Führen Sie mit der Maus entweder einen DOPPELKLICK 
auf die Zelle aus, um diese auszuwählen, und platzie-
ren Sie die Schreibmarke an die Stelle, die bearbeitet werden soll. Oder Sie führen mit der Maus 
einen EINZELKLICK aus, um die Zelle auszuwählen und KLICKEN dann in die Eingabezeile hinein, 
siehe Abbildung 21, um die Schreibmarke zur Bearbeitung zu platzieren.
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Abbildung 20: Dialog Inhalte löschen

Abbildung 21: Eingabezeile



Kopieren von Inhalten

Zelleninhalte, Kommentare, Formate und Objekte von Zellen können gezielt von einer Zelle oder 
Zellen auf andere Zellen übertragen werden.

Wählen Sie die die gewünschte Zelle oder Zellen aus und kopieren Sie sie in die Zwischenablage
• mit Bearbeiten ► Kopieren, 
• im Kontextmenü mit Kopieren oder 
• mit der Tastenkombination STRG+C.

Markieren Sie die Zelle oder Zellen, denen Sie die Inhalte oder Eigenschaften zuweisen wollen.

▪ Bearbeiten ► Inhalte einfügen ► Nur Text
Es wird nur Text eingefügt, anstelle von Zahlen oder Formeln wird der Inhalt der Zielzellen 
gelöscht.

▪ Bearbeiten ► Inhalte einfügen ► Nur Zahlen
Es werden nur Zahlen eingefügt, anstelle von Text wird der Inhalt der Zielzellen gelöscht, 
bei Formeln wird das Ergebnis der Formel eingefügt.

▪ Bearbeiten ► Inhalte einfügen ► Nur Formeln
Es werden nur Formeln eingefügt, anstelle von Text oder Zahlen wird der Inhalt der Zielzel-
len gelöscht.

▪ Bearbeiten ► Inhalte einfügen ► Transponiert
Die Zellen werden transponiert (um die Hauptdiagonale gespiegelt, siehe 
Grafik rechts, auch relative Bezüge werden umgewandelt) und alle Inhalte 
und Eigenschaften eingefügt.

▪ Bearbeiten ► Inhalte einfügen ► Inhalte einfügen oder UMSCHALT+STRG+V 
Wenn die Zwischenablage Tabellenzellen enthält, öffnet sich der Dialog Inhalte einfügen 
(siehe nachfolgende 
Beschreibungen).

Inhalte einfügen

Im Dialog Inhalte einfügen (Abbil-
dung 22) können die einzufügen-
den Zelleninhalte, Kommentare, 
Formate und Objekte individuell 
ausgewählt werden.

Voreinstellungen

Wenn Direkt ausführen ausgewählt 
bleibt, kann mit einem Klick eine 
dieser vorbereiteten Kombinatio-
nen übernommen werden:

•  Nur Werte  – Zahlen, Text 
sowie Datum und Uhrzeit 

•  Werte und Formatierungen  – Zahlen, Text, Datum und Uhrzeit und Formatierungen
•  Nur Formatierungen  – Formatierungen, ohne die Werte der Zielzellen zu verändern
•  Alles Transponieren  – Die Zellen werden transponiert (s. o.) und alle Inhalte und Eigenschaf-

ten eingefügt.

Dabei werden keine Rechenoperationen ausgeführt und Zellen nicht verschoben.

Wenn Direkt ausführen abgewählt wird, können mit den Schaltflächen die Häkchen unter Einfügen 
und Optionen entsprechend der Voreinstellungen gesetzt werden.
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Abbildung 22: Dialog Inhalte einfügen



Einfügen

Die zu übertragenden Zelleninhalte, Kommentare, Formate und Objekte können gewählt werden:
• Alles – alle Zelleninhalte, Kommentare, Formate und Objekte
• Zahlen – Zelleninhalte, die Zahlen sind
• Text – Zelleninhalte, die Text sind
• Datum und Uhrzeit – Zelleninhalte, die Datums- und Zeitwerte sind
• Formatierungen – Zellenformatierungen werden übernommen, Werte belassen
• Kommentare – Kommentare werden übernommen, Werte belassen, vorherige Kommentare 

werden überschrieben
• Objekte – OLE-Objekte, Diagrammobjekte oder Zeichnungsobjekte werden übernommen
• Formeln – Zelleninhalte, die Formeln sind

Optionen

• Als Verknüpfung – anstelle des Zelleninhalts wird eine Verknüpfung eingefügt, wenn unter 
Einfügen Alles oder Zahlen, Text, Datum und Uhrzeit oder Formeln gewählt wurde 
▪ Verknüpfungen aus anderen Dateien werden als OLE link eingefügt 
▪ Kommentare, Formate und Objekte werden kopiert

• Transponieren – die Zellen werden transponiert (um die Hauptdiagonale gespiegelt, s. o.)
• Leere Zellen überspringen – leere kopierte Zellen überschreiben keine gefüllten Zielzellen, 

auch Formatierungen und Kommentare werden dann nicht geschrieben

Rechenoperationen

Dies gilt nur für Zahlen und Formeln:
• Keine – der kopierte Inhalt wird hineingeschrieben
• Addieren – der kopierte Inhalt zum vorherigen Inhalt wird aufaddiert
• Subtrahieren – der kopierte Inhalt wird vom vorherigen Inhalt subtrahiert
• Multiplizieren – der vorherige Inhalt wird mit dem kopierten Inhalt multipliziert (Vorsicht: eine 

leere kopierte Zelle hat den Wert 0 und führt zum Wert 0, dies kann mit Leere Zellen 
überspringen umgangen werden, s. o.)

• Dividieren – der vorherige Inhalt wird durch den kopierten Inhalt dividiert (Vorsicht: eine leere 
kopierte Zelle hat den Wert 0 und führt zu einem Fehlerwert, dies kann mit Leere Zellen 
überspringen umgangen werden, s. o.)

Zellen verschieben

Anstatt die Zielzellen zu überschreiben, können sie vor dem Hineinkopieren verschoben werden:
• Ohne – die Zielzellen werden überschrieben
• Unten –  die Zielzellen und die in den betreffenden Spalten darunter liegenden Zellen werden 

nach unten verschoben
• Rechts –  die Zielzellen und die in den betreffenden Zeilen rechts davon liegenden Zellen 

werden nach rechts verschoben

Kopieren mit der Maus

Unter Umgehung der Zwischenablage können Sie Zellen auch mit der Maus kopieren. Markieren 
Sie einen rechteckigen Zellbereich oder eine Zelle. Um eine einzelne Zelle zu markieren, klicken 
Sie mit der Maus auf die Zelle und ziehen sie dann aus der Zelle heraus und wieder hinein.

Halten Sie die STRG-Taste gedrückt und ziehen Sie die Zellen in den Zielbereich auf dem Arbeits-
blatt. Wenn Sie die Maustaste loslassen, werden die Zellen sofort in den Zielbereich kopiert. Wenn 
der Zielbereich nicht leer ist, wird er ohne Rückfrage überschrieben.

Ohne STRG-Taste werden die Zellinhalte verschoben.
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Zellen verbinden

Nebeneinander oder übereinander liegende Zellen können Sie zu einer einzigen Zelle verbinden.

Markieren Sie die Zellen, die Sie verbinden wollen und
• rufen Sie Format ► Zellen verbinden und trennen ► Zellen verbinden oder Zellen 

verbinden und zentrieren auf,
• klicken Sie in der Symbolleiste Formatierungen auf 

Zellen verbinden  oder auf Zellen verbinden und zentrieren  oder
• klicken Sie im Kontextmenü der markierten Zellen auf Zellen verbinden.

Zellen verbinden und zentrieren zentriert den Inhalt der verbundenen Zelle im gleichen Schritt.

Wenn die Zellen Daten enthalten, öffnet sich der Dialog Zellen verbinden (Abbildung 23), wählen 
Sie hier, wie Sie damit verfahren wollen:

• Inhalte der ausgeblendeten Zellen in die erste  
Zelle verschieben – Die Inhalte werden, durch 
Leerzeichen getrennt, in einer Zeile dem Inhalt 
der ersten Zelle angefügt, bei Formeln wird das 
Ergebnis der Berechnung übernommen.

• Inhalte der ausgeblendeten Zellen erhalten – 
Die Inhalte bleiben in den ausgeblendeten 
Zellen gespeichert und sind nicht mehr sichtbar, 
können jedoch durch Bezüge weiterhin 
verwendet werden und erscheinen wieder, 
wenn die Zellen wieder getrennt werden.

• Inhalte der ausgeblendeten Zellen löschen – Die Inhalte werden gelöscht.

Vorsicht

Durch Zellen verbinden ergeben sich – außer, wenn Sie die Inhalte erhalten – Fehler 
in Formeln, die auf die ausgeblendeten Zellen verweisen.
Wenn Sie die Inhalte erhalten, können durch Bezüge auf ausgeblendete Zellen Werte 
verwendet werden, die nicht sichtbar sind.

Zellen trennen

Verbundene Zellen können wieder in einzelne Zellen getrennt werden. 

Markieren Sie die verbundenen Zellen und
• Rufen Sie Format ► Zellen verbinden und trennen ► Zellen trennen oder 

Zellen verbinden und zentrieren auf,
• klicken Sie in der Symbolleiste Formatierungen auf 

Zellen trennen  oder auf Zellen verbinden und zentrieren  oder
• klicken Sie im Kontextmenü der markierten Zelle auf Zellen trennen.

Zuvor in die erste Zelle verschobene Inhalte bleiben in der ersten Zelle. Inhalte, die in den ausge-
blendeten Zellen erhalten wurden, sind wieder sichtbar. Beim Verbinden gelöschte Inhalte bleiben 
gelöscht.

Entfernen von Zellen

Einzelne Zellen, ganze Zeilen oder ganze Spalten können ausgewählt und gelöscht werden. Die 
Zellen unter oder rechts der gelöschten Zellen übernehmen dabei den Platz.
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Abbildung 23: Dialog Zellen verbinden



Wählen Sie eine Zelle oder einen Bereich von Zellen aus. 
• Wählen Sie Tabelle > Zellen löschen in der Menüleiste, 
• klicken Sie mit der rechten Maustaste auf die markierten Zellen und wählen im Kontextmenü 

Löschen, oder 
• drücken Sie die Tasten STRG + -. 

Der Dialog Zellen löschen bietet vier Optionen, um festzulegen, welche Zellen gelöscht werden:
• Zellen nach oben verschieben – die ausgewählten Zellen werden gelöscht, die in den betref-

fenden Spalten darunter liegenden Zellen werden nach oben verschoben.
• Zellen nach links verschieben – die ausgewählten Zellen werden gelöscht, die in den betref-

fenden Zeilen rechts davon liegenden Zellen werden nach links verschoben.
• Ganze Zeile(n) löschen – die Zeilen, in der die ausgewählten Zellen liegen, werden gelöscht, 

die Zeilen darunter werden nach oben verschoben.
• Ganze Spalte(n) löschen – die Spalten, in der die ausgewählten Zellen liegen, werden 

gelöscht, die Spalten rechts davon werden nach links verschoben.
Um die Auswahl zu bestätigen, klicken Sie auf OK .

Zellen schützen

Um Zellen zu schützen, 
wählen Sie den entsprechen-
den Zellbereich aus. Dann 
wählen Sie Format ► Zellen 
aus. Alternativ mit einem 
Rechtsklick der Maus und 
Zellen formatieren auswählen. 
Im erscheinenden Dialog 
Zellen formatieren wählen Sie 
den Tab Zellschutz aus (siehe 
Abbildung 24) und setzen ein 
Häkchen bei Geschützt.

Wie im Dialog beschrieben, wählen Sie nun mit Extras ► Tabelle schützen den Dialog Tabelle 
schützen. Hier können Sie ein Kennwort bestimmen oder ohne Kennwort OK  klicken.

Formatieren von Daten

Daten bzw. Zellen können auf verschiedener Art und Weise formatiert werden. Sie können entwe-
der als ein Teil einer Zellvorlage und somit automatisch angewandt werden oder die Formatierung 
kann in jeder Zelle manuell durchgeführt werden. Viele manuelle Formatierungen können schon 
mit der Symbolleiste Formatierungen durchgeführt werden (s. Abbildung 25).

Viele Einstellungen und zusätzlichen Optionen können mittels eines RECHTSKLICKS mit der Maus 
auf eine Zelle ausgewählt werden. Es öffnet sich dann der Dialog Zellen formatieren. Die Format-
optionen werden im Folgenden erklärt.
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Abbildung 25: Symbolleiste Formatierungen

Abbildung 24: Zellen formatieren - Zellschutz



Hinweis

Die in diesem Abschnitt dargestellten Einstellungen und Kombinationen davon können 
als eigene Zellvorlage mit einzugebenden Namen eingestellt und gespeichert werden. 
Weitere Informationen dazu siehe Calc Handbuch Kapitel 4 – Daten formatieren.

Umbruch mehrerer Textzeilen in einer Zelle

Für jede einzelne Zelle kann definiert werden, ob 
Textzeilen mit einem automatischen Umbruch 
versehen werden sollen oder ob Zeilenumbrüche 
manuell eingegeben werden sollen.

Automatischer Textzeilenumbruch

Damit ein Text am Ende der Zelle automatisch 
umgebrochen wird, klicken Sie mit der rechten 
Maustaste auf die betreffende Zelle und wählen im 
Kontextmenü Zellen formatieren aus oder Sie 
wählen Format ► Zellen im Menü oder drücken 
STRG+1. Machen Sie im Tab Ausrichtung unter 
Eigenschaften bei Automatischer Zeilenumbruch ein 
Häkchen (siehe Abbildung 26).

Manueller Zeilenumbruch

Um einen manuellen Zeilenumbruch in eine Zelle einzufügen, führen Sie zunächst einen 
DOPPELKLICK in der betreffenden Zelle und dann einen EINZELKLICK an der Position aus (Schreib-
marke positionieren), an der Sie den Zeilenumbruch wünschen. Mit STRG+EINGABE wird der 
Zeilenumbruch eingefügt.

In Abbildung 27 sieht man die 
Ergebnisse der Verwendung von 
manuellen Zeilenumbrüchen in zwei 
Zellen. Wenn manuelle Zeilenum-
brüche eingegeben werden, ändert 
sich die Zellenbreite nicht, aber die 
Zeilenhöhe wird entsprechend der 
Anzahl der Textzeilen angepasst.

Verkleinern der Schriftgröße

Die Schriftgröße der Daten kann automatisch so angepasst 
werden, dass der Text in die Zelle passt. Um dies durchzufüh-
ren, setzen Sie im Dialog Zellen formatieren bei Option An 
Zellgröße anpassen ein Häkchen (siehe Abbildung 28).

In Abbildung 29 sehen Sie in der linken und mittleren Spalte 
den Text mit Zeilenumbruch (Schriftgröße 10 und 8), und 
rechts das Ergebnis der Einstellung An Zellgröße anpassen.
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Abbildung 27: Zwei Zellen mit manuellen Zeilenumbrüchen

Abbildung 28: An Zellgröße anpassen

Abbildung 29: Beispiel: an Zellgröße anpassen

Abbildung 26: Automatischer Zeilenumbruch
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Zahlen formatieren

Die Formatierung von Zahlen ist durch die Verwendung von 
Symbolen auf der Symbolleiste Formatierungen möglich (s. 
Abbildung 30). Wählen Sie die Zelle aus, in der die zu forma-
tierende Zahl enthalten ist, und klicken Sie dann auf das 

betreffende 
Symbol. Einige 
Symbole haben 
rechts einen 
Abwärtspfeil 
(▼), klicken Sie darauf, um die Auswahl zu sehen.

Um weitere Formatierungen auszuwählen, 
verwenden Sie im Dialog Zellen formatieren (über 
Kontextmenü Zellen formatieren oder Format ► 
Zellen im Menü oder mit STRG+1) den Tab Zahlen, 
s. Abbildung 31.

Über Ihr Betriebssystems können Sie Formate wie 
zum Beispiel Datum / Uhrzeit und Region / Sprache 
vorgeben.

Schriftart auswählen und formatieren

Schriftart wählen

Zur schnellen Auswahl der Schriftart für eine Zelle klicken 
Sie in die Zelle. In der Symbolleiste Formatierungen 
klicken Sie neben dem Schriftnamen-Feld auf den Pfeil 
nach unten und wählen eine der angezeigten Schriftarten 
aus (s. Abbildung 32).

Tipp

Sie können einstellen, ob die Schriftnamen gleich in der jeweiligen Schriftart angezeigt 
werden sollen oder in einer Einheitsschriftart. Gehen Sie zu Extras ► Optionen und 
im Dialog Optionen wählen Sie LibreOffice-Ansicht und aktivieren oder deaktivieren 
Sie die Schriftartenvorschau mit einem Häkchen bei Schriftartenvorschau aktivieren.

Schriftgröße wählen

Um die Schriftgröße zu wählen, klicken Sie in der Symbolleiste Formatierungen auf den Pfeil bei 
Schriftgröße.

Fett, Kursiv und Unterstrichen

Für das Formatieren Fett, Kursiv oder Unterstrichen, können Sie die standardmäßig vorhandenen 
Symbole rechts neben dem Schriftgrößen-Feld verwenden.

Formatieren von Daten 21

Abbildung 30: Symbole: Zahlenformate

Abbildung 32: Schriftart auswählen

Abbildung 31: Dialog Zellen formatieren: Zahlen



Zeichenfarbe und Hintergrundfarbe wählen

Um eine Zeichenfarbe oder Hintergrundfarbe zu wählen, klicken Sie auf 
den Pfeil neben dem Symbol Zeichenfarbe oder Hintergrundfarbe. 

Sie können eine Farbpalette, eine Farbe, zuletzt verwendete Farben oder 
benutzerdefinierte Farben auswählen. Wählen Sie die gewünschte Farbe 
aus (s. Abbildung 33).

Sprache wählen

Um die Sprache der Zelle einzustellen, klicken Sie mit der rechten 
Maustaste in die Zelle und wählen im Kontextmenü Zellen formatieren 
oder Format ► Zellen im Menü oder drücken STRG+1. Im Dialog Zellen  
formatieren verwenden Sie den Tab Schrift und wählen bei Sprache die 
gewünschte Sprache aus.

Schrift-Effekte

Der Tab Schrifteffekte (Abbildung 34) im Dialog 
Zellen formatieren bietet weitere Schriftoptionen an.

Überstreichung, Durchstreichung und 
Unterstreichung

Sie können aus vielen Optionen für Überstreichung, 
Durchstreichung und/oder Unterstreichung 
auswählen, einschließlich der Farbe der Linien.

In der Option Durchstreichung kann z. B. Einfach 
(Linien) oder Mit / (Schrägstriche) oder anderes 
ausgewählt werden.

Beispiele für Durchstreichung:

 

Relief

Die Optionen für Relief sind Erhaben (erhabener Text), 
Vertieft (tiefliegender Text), Kontur oder Schatten (siehe 
Abbildung 35).

Zellenausrichtung und Orientierung

Einige Symbole werden nicht standardmäßig auf der Symbolleiste 
Formatierungen angezeigt, obwohl sie in der Symbolleiste 
definiert sind. Um diese anzuzeigen, klicken Sie mit der rechten 
Maustaste auf der linken Seite der Symbolleiste auf die Abreiß-
leiste. Sie können nun im Auswahlmenü die gewünschte Forma-
tierung auswählen (Abbildung 36). Dauerhaft sichtbar sind sie, 
wenn man sie im Anpassen Symbolleisten Dialog mit dem Haken 
für die Sichtbarkeit versieht.

Einige der Symbole sind nur verfügbar, wenn Sie in Extras ► 
Optionen bei Spracheinstellungen und Sprachen ein Häkchen bei 
Asiatisch oder bei Komplexes Textlayout gesetzt haben.

Die horizontale oder vertikale Ausrichtung oder die Drehung eines Textes können Sie im Tab 
Ausrichtung im Dialog Zellen formatieren einstellen (siehe Abbildung 26 weiter oben).
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Abbildung 35: Beispiele für Relief

Abbildung 36: Formatierungen

Abbildung 34: Zellen formatieren: Schrifteffekte

Abbildung 33: 
Farbe wählen



Zellenränder formatieren

Um eine Umrandung (Rahmen/Linienart), einen Umrandungsstil 
(Rahmenstil) und/oder eine Farbe für die Ränder einer Zelle auszu-
wählen, klicken Sie in der Symbolleiste Formatierungen auf die 
kleinen Pfeile (▼) neben den Symbolen Umrandung, Umrandungsstil 
oder Umrandungsfarbe (s. Abbildung 37).

Für weitere Formatierungen wählen Sie im Dialog Zellen formatieren 
im Tab Umrandung bei Innenabstand Werte aus, um zwischen dem 
Text und den Zellenrändern Abstand zu erhalten, oder wählen Sie 
dort einen Schatten mit seiner Position und Farbe aus. 

Automatisches Formatieren von Zellen und Tabellen

Sie können die Funktion automatisches 
Formatieren verwenden, um Zellformate 
auf eine Tabelle oder auf einen ausge-
wählten Zellbereich automatisch 
anwenden zu lassen.

• Wählen Sie die Zellen einschließlich 
der Spalten- und Zeilenüberschriften 
aus, die automatisch formatiert 
werden sollen.

• Wählen Sie Format ► AutoFormat.
• Im Dialog AutoFormat (siehe Abbil-

dung 38) können Sie auswählen, 
welche der Eigenschaften Zahlen-
format, Schriftart, Ausrichtung, Ränder, Muster und Breite/Höhe automatisch anpassen in ein 
AutoFormat einzubeziehen sind. Wählen Sie ein Format aus und klicken auf OK .

AutoFormat neu definieren

Wenn Ihnen keines der vorgegebenen Formate zusagt, können Sie sich selbst ein Format 
anlegen. Formatieren Sie auf dem Tabellenblatt einen Bereich von mindestens 4 x 4 Zellen so, wie 
Ihre Tabelle später aussehen soll, siehe z. B. Abbildung 39.

• Markieren Sie diesen Bereich. 
• Wählen Sie Format ► AutoFormat. 
• Klicken Sie im Dialog AutoFormat (siehe Abbildung 38) auf 

Hinzufügen , im sich öffnenden Dialog geben Sie einen Namen, 
z. B. Pastell, für das neue Format ein und klicken OK . 

Das neue Format wird nun links mit Namen (Pastell) und in der Mitte optisch angezeigt. Nun 
können Sie das Format Pastell verwenden, wie oben beschrieben.

Wenn die Veränderungen der Farbe des Zellinhalts nicht angezeigt werden, wählen Sie Ansicht 
► Werte hervorheben im Menü oder betätigen STRG+F8. Diese Funktion wirkt sich nur auf Zellen 
mit numerischen Daten aus.

Hinweis

Für Zellenbereiche, die keine Spalten- und Zeilentitelköpfe haben, ist AutoFormat 
nicht verfügbar.
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Abbildung 37: 
Zellenränder formatieren

Abbildung 38: Dialog AutoFormat

Abbildung 39: Beispiel: 4 x 4 
formatierte Zellen auf dem Blatt



Tabellen mit Themen formatieren

Nach der Installation von LibreOffice stehen sogenannte Themen zur Verfügung. Diese können 
Sie auch in Calc anwenden. Es ist allerdings nicht möglich, Themen in Calc hinzuzufügen oder 
diese zu modifizieren. Jedoch können Sie ihre Formatvorlagen modifizieren, nachdem Sie die auf 
einer Tabelle angewandt haben.

Wenn Sie also komplexe Formatierungen für Ihre Tabelle häufig benötigen, legen Sie sie auf dem 
Tabellenblatt mit allen Formatierungen an. Dann Markieren Sie Ihre Tabelle und legen sich ein 
AutoFormat an, siehe hier oben AutoFormat neu definieren.

Um ein Thema auf einer Tabelle 
anzuwenden:

• Wählen Sie die Symbolleiste 
Extras mit Ansicht ► Symbol-
leisten ► Extras. Klicken Sie in 
der Symbolleiste Extras auf das 
Symbol Themen-Auswahl . Der 
Dialog Themen-Auswahl ist nun 
sichtbar und listet die verfügbaren 
Themen auf (siehe Abbildung 40).

• Im Dialog Themen-Auswahl 
wählen Sie das Thema, das Sie anwenden möchten. Sobald Sie ein Thema anklicken, wird 
das Tabellenblatt mit den entsprechenden Eigenschaften dargestellt (siehe Abbildung 40).

• Klicken Sie auf OK . 

Wenn Sie es wünschen, können Sie jetzt Formatvorlagen anwenden. Diese Modifikationen verän-
dern nicht das Thema, sie ändern nur die Darstellung dieses spezifischen Dokuments.

Bedingte Formatierungen

Sie können Zellen in Abhängigkeit von Bedingungen, die Sie vorgeben, formatieren. Beispielswei-
se können Sie in einer Tabelle alle Werte, die über dem Durchschnitt liegen, in grün und alle 
Werte, die unter dem Durchschnitt liegen, in rot anzeigen lassen.

Hinweis

Um bedingte Formatierung anzuwenden, muss die automatische Berechnung aktiviert 
sein. Dazu wählen Sie Daten ► Berechnen ► Automatisch.

Eine bedingte Formatierung hängt von der Verwendung der Vorlagen ab. Wenn Sie nicht mit 
Formatvorlagen vertraut sind, können Sie Details dazu im Calc Handbuch Kapitel 4 – Daten 
formatieren nachlesen.

Unter der Voraussetzung, dass Vorlagen vorhanden sind, gehen 
Sie wie folgt vor, um eine bedingte Formatierung anzuwenden.

• Selektieren Sie die Zellen, in denen Sie eine bedingte 
Formatierung anwenden möchten.

• Klicken Sie in der Symbolleiste Formatierungen auf das 
Symbol Bedingte Formatierung und wählen Bedingung und 
Weitere Regeln (siehe Abbildung 41; mit den anderen 
Auswahlmöglichkeiten kann die jeweilige Einstellung direkt 
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Abbildung 40: Themen-Auswahl

Abbildung 41: Auswahl Bedingte 
Formatierung
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in einem spezifischen Dialog gewählt werden, mit Verwalten können alle bereits erstellten 
Bedingten Formatierungen der Tabelle bearbeitet werden).

• Im Dialog Bedingte Formatierung (siehe Abbildung 42) geben Sie die Bedingungen ein.

• Klicken Sie auf OK , um diese abzuspeichern. 

Die ausgewählten Zellen sind jetzt gemäß Ihren Vorgaben formatiert.

Zellwert / Formel ist / Datum ist / Alle Zellen

In Bedingungen kann Zellwert, Formel ist, Datum ist oder Alle Zellen 
ausgewählt werden. Dies gibt an, ob die bedingte Formatierung von 
einem Zellwert, von einer Formel, als Datum von einem Tag oder von 
allen Zellen abhängig ist.

Wenn Sie Zellwert auswählen, wird das Bedingungsfeld für Zahlen 
angezeigt (Abbildung 43). Hier können Sie Bedingungen wie z. B. 
kleiner als, größer als oder zwischen auswählen.

Wenn Sie Formel ist wählen, kann eine Formel ins daneben liegende 
Feld eingegeben werden, es wird ausgewertet, ob der Formelausdruck 
nicht Null ist.

Wird Datum ist ausgewählt, erscheint das Bedingungsfeld für Datum 
(Abbildung 44) und Sie können relative Datumsangaben als Bedingung wählen.

Wird Alle Zellen ausgewählt, können vielfältige Bedingte Formatierungen durch 
Farbbalken mit 2 oder 3 Einträgen, einem Datenbalken oder ein Symbolsatz aus 
einer Auswahl gewählt werden.

Bedingte Formatierung ist ausführlich im Calc Handbuch Kapitel 4 – Daten  
formatieren beschrieben.

Parameterfeld

Falls die Bedingung dies benötigt, geben Sie in das Parameterfeld einen Bezug, 
einen Wert oder eine Formel ein. Bei Bedingungen, die zwei Parameter erfordern, 
erscheint dafür ein zweites Parameterfeld. Formeln können Sie auch mit relativen 
Bezügen eingeben.

Zellvorlage

Wählen Sie die Zellvorlage, die angewandt werden soll, wenn die zuvor definierte Bedingung 
zutrifft. Die Vorlage muss vorher definiert worden sein.

Formatierung kopieren

Um die Formatierung einer Zelle auf andere Zellen anzuwenden, verwenden Sie Inhalte einfügen 
(siehe Abschnitt Kopieren von Inhalten) und wählen darin Formatierungen (siehe Abbildung 45):
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Abbildung 43: Zellwert 
Bedingungsfeld für Zahlen

Abbildung 42: Dialog Bedingte Formatierung

Abbildung 44: 
… für Datum
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• Wählen Sie die Zelle mit der gewünschten 
Formatierung aus.

• Kopieren Sie die Zelle in die Zwischenablage.
• Markieren Sie die Zellen, denen Sie die 

Zellvorlage zuweisen wollen.
• Wählen Sie Bearbeiten ► Inhalte einfügen 

► Inhalte einfügen aus.
• Im Dialog Inhalte einfügen, selektieren Sie 

unter Einfügen nur die Option Formatierungen. 
Überprüfen Sie, ob alle anderen Optionen 
nicht ausgewählt sind und klicken Sie auf OK .

Ausblenden, Gruppieren und Filtern von Daten

Ausblenden und Anzeigen

Wenn Elemente ausgeblendet sind, sind diese weder sichtbar noch können diese gedruckt 
werden. Allerdings können diese trotzdem zum Kopieren ausgewählt werden, wenn die Elemente 
um sie herum ausgewählt werden. Wenn beispielsweise die Spalte B ausgeblendet ist, wird diese 
bei der Auswahl der Spalten A und C mit kopiert.

Wenn Sie ein verborgenes Element wieder sichtbar machen wollen, können Sie den Vorgang 
umkehren und das Element wieder anzeigen lassen.

Um Zeilen oder Spalten auszublenden oder wieder einzublenden, verwenden Sie die entsprechen-
den Optionen in den Zeilen- und Spaltenbeschriftungen (A, B, C etc., bzw. 1, 2, 3 etc.), klicken Sie 
mit der rechten Maustaste und wählen Spalten ausblenden bzw. Zeilen ausblenden. Oder Sie 
wählen im Menü Format ► Zeilen ► Ausblenden, bzw. Format ► Spalten ► Ausblenden. 
Wenn Sie zum Beispiel eine Zeile ausblenden möchten, wählen Sie zuerst die Zeile und wählen 
dann Format ► Zeilen ► Ausblenden.

Gruppierung und Gliederung von Steuerelementen

Wenn Sie wiederholt das Aus- und Einblenden derselben Zellen durchführen wollen, können Sie 
den Vorgang durch das Erstellen einer Gruppierung und Gliederung vereinfachen.

Wenn die Inhalte von Zellen in ein regelmäßiges Muster fallen 
wie zum Beispiel vier Zellen gefolgt von einer Summe, dann 
können Sie die AutoGliederung verwenden. Dazu markieren 
Sie die Zellen und wählen im Menü Daten ► Gruppierung 
und Gliederung ► AutoGliederung. In unserem Beispiel wird 
links neben der Zeilenbeschriftung ein Bereich kenntlich 
gemacht. Die senkrechte Bereichsanzeige hat oben ein Minus-
zeichen -  (Abbildung 46 oben). Wenn man darauf klickt, 
werden die durch einen Balken markierten Zeilen ausgeblen-
det. Nun ist ein Pluszeichen +  zu sehen (Abbildung 46 unten), 
mit dem die Gruppierung wieder eingeblendet werden kann.

Alternativ können Sie Gliederungen auch manuell durch die Auswahl der Zellen für die Gruppie-
rung erstellen. Wählen Sie dazu Daten ► Gruppierung und Gliederung ► Gruppierung. Im 
Dialog Gruppieren können Sie angeben, ob die ausgewählten Zellen in Zeilen oder Spalten 
gruppiert werden sollen.
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Abbildung 46: AutoGliederung

Abbildung 45: Inhalte einfügen: Formatierungen



Im Gliederungs-Modus sind Pluszeichen +  oder Minuszeichen -  am Anfang der Gruppe zu sehen. 
Damit können verborgene Zellen angezeigt oder verborgen werden. Wenn die Gliederung 
verschachtelt ist, werden nummerierte Schaltflächen angezeigt, um die verschiedenen Ebenen 
darzustellen (in Abbildung 46 links oben zu sehen).

Wenn Sie eine Gruppe nicht länger benötigen, wählen Sie eine beliebige Zelle darin aus und 
wählen Daten ► Gruppierung und Gliederung ► Gruppierung aufheben. Um alle Gruppen 
aus einer Tabelle zu entfernen, wählen Sie Daten ► Gruppierung und Gliederung ► Gliede-
rung entfernen.

Filtern, welche Zellen sichtbar sind

Ein Filter ist eine Liste von Bedingungen, diese geben vor, welche Daten 
angezeigt werden sollen. In Berechnungen werden auch die durch Filter 
nicht sichtbaren Zellen ausgewertet. Es gibt drei Arten von Filtern, die Sie 
über das Menü Daten festlegen können.

AutoFilter

Für den automatischen Filter wählen Sie eine Zelle in einem Bereich von 
belegten Zellen aus und wählen Daten ► AutoFilter. Dies fügt ein 
Auswahlmenü zu der obersten Zeile des Bereichs hinzu und ist nun an 
den Auswahl-Pfeilen  ersichtlich. Die Liste enthält häufig verwendete 
Filter für Text- und Zahlendaten (s. Abbildung 47).

In Nach Bedingung filtern gibt es Optionen für Zellen, die Leer oder Nicht  
leer sind und Höchste oder Niedrigste 10 Zahlenwerte, um die Darstellung 
der Tabelle zu beeinflussen. Außerdem gibt es einen Standardfilter, den 
Sie individuell einrichten können (siehe unten Standardfilter).

Die Filter ermöglichen nicht die Eingabe von regulären Ausdrücken. Deshalb können Sie die Filter 
nicht benutzen, um Zelleninhalte anzuzeigen, die ähnlich aber nicht identisch sind.

Standardfilter

Standardfilter sind komplexer als AutoFilter und 
können in der Menüauswahl des AutoFilter 
unter Nach Bedingung filtern und über Daten ► 
Weitere Filter ► Standardfilter eingestellt 
werden. In Standardfiltern können Sie bis zu 
vier Bedingungen als Filter einstellen und diese 
mit den Operatoren UND  bzw. ODER  kombi-
nieren. Standardfilter eignen sich hauptsächlich 
für Zahlen. Sie können aber auch einige der 
abhängigen Operatoren wie zum Beispiel = und 
< > für Text benutzen (siehe Abbildung 48).

Andere abhängige Operatoren für Standardfilter 
enthalten Bedingungen, um die größten oder 
kleinsten Werte oder einen Prozentsatz 
anzuzeigen. Mit Standardfilter können auch 
automatische Filter verfeinert werden.
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Abbildung 47: AutoFilter 
Auswahlmenü

Abbildung 48: Standardfilter



Erweiterte Filter

Erweiterte Filter werden in Daten ► Weitere 
Filter ► Spezialfilter eingestellt und sind 
genauso wie Standardfilter aufgebaut, sind 
jedoch nicht auf drei Bedingungen begrenzt. 
Die Kriterien werden nicht in einen Dialog 
eingegeben, stattdessen werden erweiterte 
Filter in einen leeren Bereich einer Tabelle 
eingegeben und mit einem Verweis durch das 
erweiterte Filterwerkzeug versehen, um sie 
anzuwenden (siehe Abbildung 49).

Sortieren von Datensätzen

Sortierkriterien

Das Sortieren ordnet die sichtbaren Zellen in einer Tabelle neu an. Die Sortierung kann mit bis zu 
drei Kriterien erfolgen, welche der Reihe nach angewandt werden. Sortiervorgänge sind praktisch, 
wenn Sie nach besonderen Details suchen. Sortieren ist in gemeinsamer Verwendung mit Filtern 
ein leistungsstarkes Instrument.

Darüber hinaus ist die Sortierung oft hilfreich, 
wenn Sie neue Informationen hinzufügen. Wenn 
eine Liste lang ist, ist es im Allgemeinen einfacher, 
neue Informationen am unteren Ende der Tabelle 
anzufügen, anstatt Zeilen an der richtigen Stelle 
einzufügen. Nachdem Sie die Informationen 
angefügt haben, können Sie eine Aktualisierung 
der Tabelle mittels Sortierung durchführen.

Markieren Sie die Zellen, die sortiert werden 
sollen, und wählen Sie anschließend Daten ► 
Sortieren, um den Dialog Sortierung zu öffnen (s. 
Abbildung 50).

Mit der Auswahl im Dialog können Sie bei ausge-
wählten Zellen nach Kriterien in bis zu drei Ebenen 
entweder aufsteigend (A–Z bzw. 1–9) oder abstei-
gend (Z–A bzw. 9–1) sortieren.

Vorsicht

Ein häufiger Fehler im Umgang mit mehrspaltigen Listen ist es, einzelne Spalten darin 
zu sortieren. Wird nur eine Spalte sortiert, dann bleiben die anderen Spalten unverän-
dert und die Zuordnung der Listenfelder zueinander geht verloren.

Hinweis

Verwenden Sie in der Symbolleiste Standard die Symbole Aufsteigend sortieren  
oder Absteigend sortieren , so wird der zuvor markierte Bereich in einer einzigen 
Ebene nach der Spalte sortiert, die ausgewählt ist.
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Abbildung 49: Erweiterte Filter

Abbildung 50: Sortierung - Sortierkriterien



Sortieroptionen

Unter Kopfzeilen kann durch Auswahl von Bereich enthält Spaltenbeschriftungen eine Kopfzeile 
bestimmt werden, die nicht mit sortiert wird.

Unter Richtung geben Sie an, ob Zeilen Von oben nach unten oder Spalten Von links nach rechts 
sortiert werden sollen. Die Vorgabe ist eine Sortierung der Zeilen.

Im Tab Optionen (Abbildung 51), können Sie weite-
re Sortieroptionen wählen:

Groß- und Kleinschreibung

Wird Groß- und Kleinschreibung gewählt, dann 
werden Großbuchstaben wie die entsprechenden 
Kleinbuchstaben behandelt. 

Andernfalls erscheinen kleingeschriebene 
Buchstaben zuerst, wenn die Sortierung abstei-
gend ist, großgeschriebene Buchstaben erfolgen 
zuerst, wenn die Sortierung aufsteigend ist.

Formate einschließen

Eine Zell-Formatierung wird mit seinen Inhalten 
verschoben. Wenn Formatierung verwendet wird, 
um verschiedene Typen von Zellen zu unterscheiden, dann ist diese Option zu benutzen.

Sortierergebnis ausgeben nach

Wird diese Option gewählt, dann werden die sortierten Zellen nicht ersetzt, sondern Sie können 
einen Benannten Bereich (siehe Tabelle ► Benannte Bereiche ► …) wählen oder einen Zellbe-
reich festlegen, wohin die Sortierergebnisse ausgegeben werden sollen.

Wenn ein Bereich spezifiziert wird, der nicht die notwendige Zellenanzahl hat, wird der Zellbereich 
entsprechend erweitert. Enthält der Bereich bereits Inhalte, werden diese überschrieben.

Benutzerdefinierte Sortierreihenfolge

Mit Benutzerdefinierte Sortierreihenfolge können Sie in der Auswahlliste eine von den Sortierrei-
henfolgen auswählen, die in Extras ► Optionen ► LibreOffice Calc ► Sortierlisten definiert 
sind.

Sprache

Für einige Sprachen können unterschiedliche Optionen für die Sortierung gewählt werden (z. B. 
für Chinesisch Pinyin, Stroke, Zhuyin, Radikal oder Zeichensatz, oder für Deutsch z. T. Alphanu-
merisch oder Telefonbuch, wo die Umlaute unterschiedlich eingeordnet werden).

Suchen und ersetzen

Es gibt es mehrere Möglichkeiten, innerhalb eines Calc-Dokuments bestimmte Informationen wie 
Text, Formeln oder Formate zu finden.

• Verwenden Sie die Symbolleiste Suchen, die sich über Bearbeiten ► Suchen oder die 
Tastenkombination STRG+F öffnet.
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Abbildung 51: Sortierung - Optionen



• In der Symbolleiste Standard können Sie das Symbol Suchen und ersetzen  anklicken, es 
öffnet sich den Dialog Suchen und Ersetzen.

• Über Bearbeiten ► Suchen und ersetzen öffnet sich der Dialog Suchen und Ersetzen.

Symbolleiste Suchen

Die Symbolleiste Suchen (Abbildung 52) befindet sich als Vorgabe unten, über der Statusleiste. 
Sie können die Symbolleiste Suchen mit Ansicht ► Symbolleisten ► Suchen verbergen oder 
anzeigen.

Schreiben Sie einen Begriff den Sie suchen, in das Suchfeld, und klicken Sie dann auf eines der 
Symbole Vorherigen suchen (Pfeil nach oben ) oder Nächsten suchen (Pfeil nach unten ).

Dialog Suchen und Ersetzen

Um den Dialog Suchen und  
Ersetzen anzuzeigen, verwen-
den Sie die Tastenkombination 
STRG+ALT+F oder wählen Sie 
über das Menü Bearbeiten ► 
Suchen und ersetzen oder 
über die Symbolleiste Standard 
das Symbol Suchen und erset-
zen aus (siehe Abbildung 53).

Sie können von einer Fundstelle 
zur nächsten navigieren oder 
Sie können alle passenden 
Zellen markieren und auf einmal 
mit Alle Suchen durchsuchen. 
Gleichzeitig haben Sie die Möglichkeit, gefundene Inhalte durch ein anderes Format oder durch 
andere Zelleninhalte zu ersetzen.

Text und Zahlen in Zellen können direkt eingegeben sein. Es kann aber auch nach dem Ergebnis 
einer Berechnung gesucht werden. Die Suchmethode, die Sie benutzen, hängt von dem Datentyp 
ab, nach dem Sie suchen.

Tipp

Zelleninhalte können auf verschiedene Arten formatiert sein. Zum Beispiel kann eine 
Zahl als eine Währung formatiert sein, um diese mit einem Währungssymbol anzuzei-
gen. Sie sehen zwar das Währungssymbol in der Zelle, aber Sie können nicht danach 
suchen, da es sich um eine Formatierung handelt. Um nach formatierten Zellen zu 
suchen, können Sie die Option Formatierte Anzeige verwenden.

Standardmäßig durchsucht Calc die aktuelle Tabelle. Um alle Tabellen des Dokuments zu durch-
suchen, wählen Sie Alle Tabellen aus. Klicken Sie auf Weitere Optionen um aus weiteren Optionen 
zu wählen; einige Optionen werden nur angeboten, wenn unter Extras ► Optionen ► Sprachen 
und Gebietsschema ► Allgemein Asiatisch oder Komplexes Textlayout angewält wurden.
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Abbildung 52: Symbolleiste Suchen

Abbildung 53: Dialog Suchen und Ersetzen



Vorsicht

Benutzen Sie Alle Ersetzen  mit Vorsicht, da sehr schnell unerwünschte Effekte 
eintreten können. Ein Fehler mit Alle Ersetzen  könnte dann zum Beispiel eine 
manuelle Wort-für-Wort-Durchsuchung zur Folge haben.

Suchen und ersetzen von Formeln oder Werten

Sie können den Dialog Suchen und Ersetzen benutzen, um in Formeln oder in Zellen mit berech-
neten Werten zu suchen (siehe Abbildung 53).

• Um den Dialog Suchen und Ersetzen zu öffnen, benutzen Sie die Tastenkombination 
STRG+ALT+F oder wählen Bearbeiten ► Suchen und ersetzen.

• Klicken Sie auf Weitere Optionen, um den Dialog zu erweitern.

• Wählen Sie Formeln oder Werte in der Auswahlliste Suchen in.
▪ Formeln findet Teile der Formeln oder Text.
▪ Werte findet die Ergebnisse der Berechnungen.

• Tippen Sie im Feld Suchen den Text ein, den Sie finden wollen.

• Um den Text duch einen abweichenden Text zu ersetzen, geben Sie den neuen Text im Feld 
Ersetzen ein.

• Wenn Sie Ihre Suche eingerichtet haben, klicken Sie auf Nächsten suchen . Um den Text zu 
ersetzen, klicken Sie stattdessen auf Ersetzen .

Suchen und ersetzen von Text

• Öffnen Sie den Dialog Suchen und Ersetzen, klicken Sie 
auf Weitere Optionen, um den Dialog zu erweitern, und 
wählen Sie Werte oder Kommentare in der Auswahlliste 
Suchen in, Abbildung 54.

• Tippen Sie den Text, den Sie finden wollen, im Feld Suchen ein.

• Um den Text durch einen abweichenden Text zu ersetzen, geben Sie den neuen Text im Feld 
Ersetzen ein.

• Klicken Sie auf Nächsten suchen , Alle suchen , Ersetzen  oder Alle ersetzen .

Wenn Sie auf Nächsten suchen 
klicken, wird die nächste Zelle ausge-
wählt, die den gesuchten Text enthält. 
Sie können nun den Text bearbeiten. 
Klicken nochmals auf Nächsten  
suchen , um zur nächsten Zelle zu 
springen, die den gesuchten Text 
enthält.

Wenn Sie auf Alle suchen  klicken, 
wird der Dialog Suchergebnisse 
angezeigt und alle Zellen werden 
markiert, die Ihren Eintrag enthalten 
(siehe Abbildung 55). Jetzt können 
Sie zum Beispiel eine Zellenvorlage 
auf alle gefundenen Stellen anwenden.
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Abbildung 54: Auswahlliste Suchen in

Abbildung 55: Suchen und ersetzen - Alle suchen



Suchen und ersetzen von Zellvorlagen

Zum schnellen Ersetzen aller Zellen mit einer unerwünschten Vorlage durch eine andere Vorlage 
gehen Sie wie folgt vor:

• Setzen Sie im Dialog Suchen und Erset-
zen in den Weiteren Optionen ein 
Häkchen bei Zellvorlagen. Die Felder 
Suchen und Ersetzen enthalten jetzt 
eine Liste von Vorlagen (s. Abbildung
56).

• Wählen Sie die Vorlage für Suchen und 
für Ersetzen aus damit die Vorlagen 
ersetzt werden können.

• Klicken Sie dann auf Nächsten suchen , Alle suchen , Ersetzen  oder Alle ersetzen .

Platzhalter und reguläre Ausdrücke

Mit Platzhaltern und regulären Ausdrücken können Sie LibreOffice durch Kombinationen von 
Schriftzeichen genauer anweisen, wonach gesucht wird.

• Platzhalter sind einfacher zu verwenden.
• Reguläre Ausdrücke sind sehr leistungsstark, aber nicht sehr intuitiv im Sinne von 

selbsterklärend.
Sie können aber in beiden Fällen durch Kombinieren von mehreren Suchkriterien Zeit und 
Aufwand sparen.

Um Platzhalter oder reguläre Ausdrücke beim Suchen und Ersetzen zu verwenden, gehen Sie wie 
folgt vor:

• Im Dialog Suchen und Ersetzen klicken Sie auf Weitere Optionen, um mehr Auswahlmöglich-
keiten zu sehen. In diesem erweiterten Dialog wählen Sie die Option Platzhalter bzw. die 
Option Reguläre Ausdrücke aus. Diese beiden Optionen sind nicht kombinierbar.

• Geben Sie in dem Feld Suchen den Suchtext einschließlich der Platzhalter oder der regulären 
Ausdrücke ein bzw. bei einem Ersetzen-Wunsch auch den Ersetzungstext in dem Feld Erset-
zen ein.

• Klicken Sie auf Nächsten suchen , Alle suchen , Ersetzen  oder Alle ersetzen .

Tipp

Unter https://help.libreoffice.org/24.2/de/text/scalc/guide/wildcards.html und unter 
https://help.libreoffice.org/24.2/de/text/swriter/guide/search_regexp.html finden Sie in 
der Online-Hilfe weitere Information zu Platzhaltern und regulären Ausdrücken und 
ihren Anwendungen.

Platzhalter

Der Gebrauch von Platzhaltern ermöglicht eine einfachere gezielte Suche in einem Text. Nur die 
drei Zeichen Fragezeichen ?, Sternchen * und Tilde ~ sind hier als Metazeichen definiert:

▪ Das Fragezeichen ? wird im Suchtext für ein beliebiges einzelnes (genau ein) Zeichen 
eingesetzt. Das Muster “T?m“ findet “Tim“ und “Tam“ aber nicht “Tm“ und nicht “Traum“.
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▪ Das Sternchen * wird für eine beliebige Anzahl von Zeichen (auch die Anzahl 0) eingesetzt. 
Das Muster “R*um“ findet, “Raum“, “Radium“ und “Rum“ aber nicht “Ruhm“.

▪ Mit einer vorangestellten Tilde ~ kann die Bedeutung der Metazeichen ? und * entwertet 
werden, um mit ~? nach dem Fragezeichen und mit ~* nach dem Sternchen zu suchen.

Die Platzhalter unterscheiden nicht nach Groß- und Kleinschreibung, die Suche nach "Hut" findet 
sowohl "hut" als auch "huT" und "HUT". 

Reguläre Ausdrücke
Für reguläre Ausdrücke ist der Umfang von Metazeichen größer: .  ^  $  *  +  ?  \  [  ]   |  {  }  (  ) 
Für die wichtigsten Metazeichen sind hier einige kurze Beispiele beschrieben:

regulärer 
Ausdruck

Beschreibung

r.t Punkt .: ein beliebiges Zeichen, also rat, rot und r@t, aber nicht rt

Was*er Sternchen *: beliebig viele des Zeichens davor, hier ein s, also Wasser, Waser, 
Wasssser und auch Waer

Was+er Pluszeichen +: ein oder mehrere des Zeichens davor, hier ein s, also Wasser, 
Waser, Wasssser aber nicht Waer

Mau?l Fragezeichen ?: keinmal oder einmal das Zeichen davor, hier ein u, also Mal 
oder Maul, aber nicht Mahl

Be[srl]t eckige Klammern [ und ]: genau eines der enthaltenen Zeichen, also Best, Bert 
oder Belt, aber nicht Berlt

Was{2,4}er geschweifte Klammern { und }: genau 2 bis 4 des Zeichens davor, hier ein s, also 
Wasser, Wassser, und Wasssser, aber nicht Waer, Waser und Wassssser

B[aeiou]{1,2}r das Zeichen vor den geschweiften Klammern kann auch ein Metazeichen sein, 
hier also genau ein oder 2 Vokale zwischen B und r: Bar, Baer, Bier, Bor aber 
nicht Bauer

^T Zirkumflex, Caret ^: der Buchstabe T am Zeilenanfang

ung$ Dollarzeichen $: das Wortende ung am Zeilenende

^A.*ung$ eine Zeile beginnt mit A und endet mit ung, dazwischen beliebig viele und belie-
bige Zeichen, also Achtung und Ahnung, aber nicht Alling

Die folgenden Beispiele können hierzu von Interesse sein:

• In Calc wird ein regulärer Ausdruck auf jede Zelle separat angewandt. Dies bedeutet, dass 
eine Suche nach r.t in Zelle A1 Rot finden wird, aber es wird nicht r in Zelle A2 und t (oder ot) 
in Zelle A3 finden.
Der reguläre Ausdruck r.t bedeutet, dass Calc r gefolgt von irgendeinem anderen Schriftzei-
chen gefolgt von t finden wird.

• Wenn eine Übereinstimmung gefunden ist, ist die vollständige Zelle hervorgehoben, aber nur 
der gefundene Text wird ersetzt. Zum Beispiel wird Durchsuchen nach braun die Hervorhe-
bung einer Zelle mit rotbrauner Lehm ergeben.
Tragen Sie blau im Ersetzen-Feld ein, wird Ersetzen in der Zelle rotblauer Lehm ergeben.

• Wenn das Suchen in einer Zeile zweimal verwendet wird und das zweite Mal das Feld Nur 
ganze Wörter aktiviert ist, dann wird die zweite Suche das Ganze von jeder ausgewählten 
Zelle auswerten und nicht nur die Zeichenfolgen in den Zellen, die für die erste Suche ausge-
wählt worden sind.
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Beispiel: das Durchsuchen nach joh?n und danach das Aktivieren von Nur ganze Wörter und 
die Suche nach sm.th wird die beiden Zellen mit Jon Smith und Smythers, Johnathan 
finden.

• Wenn eine Zelle einen harten Zeilenumbruch enthält (eingegeben durch STRG+EINGABE), 
kann diese durch die Verwendung des regulären Ausdrucks \n gefunden werden.

• Der harte Zeilenumbruch erwirkt Textende (ähnlich wie Abschnittsende in Writer) und kann 
durch das Sonderzeichen $ im regulären Ausdruck gefunden werden. Zugleich wird das 
Textende in der Zelle markiert.
Wenn zum Beispiel eine Zelle roter [harter Zeilenumbruch] Lehm enthält und eine Suche 
roter$ mit Ersetzen blauer durchgeführt wird, erfolgt der Eintrag blauer [harter Zeilenum-
bruch] Lehm. Beachten Sie, dass mit dieser Syntax der harte Zeilenumbruch nicht ersetzt 
wird.

• Mit \n in dem Feld Ersetzen wird mit den unveränderlichen Zeichen \n kein harter Zeilenum-
bruch ersetzt.

• Der Dialog Suchen und Ersetzen hat auch eine Option, innerhalb von Formeln, Werten oder 
Kommentaren zu suchen. Diese Option gilt für jede Art von Suche. Das Durchsuchen nach 
Summe würde mit der Option Formeln zum Beispiel eine Zelle mit der Formel 
=Summe(A1:A6) finden.

• Das Durchsuchen mit dem regulären Ausdruck ^$ findet keine leere Zellen – auch nicht, wenn 
Sie nur einen kleinen Bereich zum Durchsuchen angegeben haben. Dieses Verhalten ist so 
gewünscht, um Leistungsprobleme zu vermeiden, wenn eine hohe Anzahl von Zellen zum 
Durchsuchen ausgewählt worden sind.

• Das Finden des gesamten Zelleninhalts mit dem regulären Ausdruck .+ und das Ersetzen mit 
& führt dazu, dass Zelleninhalte ohne jegliche Formatierung wieder eingetragen werden. 
Damit ist es möglich, unter Verwendung der automatischen Formatierung beim Importieren 
von Daten aus der Zwischenablage oder beim Vorliegen von nicht optimal formatierten Daten 
bestimmte Inhalte zu entfernen. So können zum Beispiel zusammengesetzte Textzeichenfol-
gen mit Ziffern in konkrete Zahlen umgewandelt werden. Dazu werden zunächst die Zellen als 
Zahlen formatiert und erst dann wird das Suchen und Ersetzen durchgeführt.
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Weitere Informationen

Handbücher der LibreOffice Community

Die Handbücher für die einzelnen Anwendungen bestehen aus mehreren Kapiteln. Die Kapitel-
übersichten finden Sie auf der Webseite von LibreOffice - The Document Foundation

LibreOffice Handbücher (auf deutsch) / https://de.libreoffice.org/get-help/documentation/

LibreOffice Handbücher (englische Versionen) / 
https://wiki.documentfoundation.org/Documentation/Publications

LibreOffice bietet sechs Anwendungen (Komponenten) für die Erstellung und Bearbeitung
von Dokumenten und zur Datenverarbeitung:

• Writer - Textverarbeitung

• Calc - Tabellenkalkulation

• Impress - Präsentationen

• Draw - Zeichnungen

• Base - Datenbanken

• Math - Formeleditor

Die Kapitel

Jeder, der sich schnell mit LibreOffice vertraut machen möchte, wird die Kapitel zu schätzen 
wissen. Vielleicht sind Sie neu in der LibreOffice Suite oder Sie sind mit einer anderen Office-Suite 
vertraut. Die Kapitel von LibreOffice bieten Ihnen themengenaue Informationen.

PDF-Versionen

Alle Kapitel können frei als PDF-Version heruntergeladen werden:

LibreOffice Handbücher (auf deutsch) / https://de.libreoffice.org/get-help/documentation/

Die Autoren

Die Handbücher werden von Freiwilligen der LibreOffice-Community erstellt.

Über LibreOffice

LibreOffice ist eine leistungsfähige Office-Suite, für verbreitete Betriebssysteme wie Windows, 
GNU/Linux 32-/64-Bit und Apple Mac OS X geeignet.

LibreOffice entsteht aus der kreativen Zusammenarbeit von Entwicklern und der Gemeinschaft der 
Stiftung The Document Foundation / https://de.libreoffice.org/about-us/governance/. Die Stiftung 
hat ihren Sitz in Berlin / Deutschland.

Das Programm LibreOffice kann unter der Adresse LibreOffice Download / 
https://de.libreoffice.org/download/download/ kostenlos heruntergeladen werden.
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Kapitelübersicht - Calc Handbuch

Kapitel 1 - Einführung

Kapitel 2 - Eingeben und Bearbeiten von Daten 

Kapitel 3 - Diagramme und Schaubilder

Kapitel 4 - Daten formatieren

Kapitel 5 - Format- und Dokumentvorlagen

Kapitel 6 - Bilder und Grafiken

Kapitel 7 - Drucken, Exportieren, E-Mailen und Signieren

Kapitel 8 - Formeln und Funktionen verwenden

Kapitel 9 - Pivot-Tabellen

Kapitel 10 - Datenanalyse

Kapitel 11 - Daten verknüpfen

Kapitel 12 - Gemeinsame Nutzung und Auswertung von Tabellen

Kapitel 13 - Makros

Kapitel 14 - Calc als Datenbank verwenden

Kapitel 15 - Einrichten und Anpassen

Kapitel 16 - Varianten der Benutzeroberfläche

Anhang A - Tastaturkürzel

Anhang B - Fehlermeldungen

Anhang C - Calc Funktionen

Anhang D - Pivot-Tabellen - Beispiele und Lösungsansätze
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Hilfe

So verwenden Sie die Hilfe von LibreOffice.

Offline-Hilfe

Die Offline-Hilfe steht Ihnen nur zur Verfügung, wenn Sie sie auch installiert haben.

Platzieren Sie den Cursor an eine Stelle (Menü, Dialog etc.), an der Sie Hilfe benötigen.

Betätigen Sie die Taste F1, (bei Laptops evtl. FN+F1).

Online-Hilfe

Die Online-Hilfe wird Ihnen angeboten, wenn Sie keine Offline-Hilfe installiert haben.

Sie können die Online-Hilfe aber auch direkt in Ihrem Internetbrowser öffnen:

LibreOffice online Hilfe

Offline- und Online-Hilfe

Beide Hilfesysteme öffnen sich jeweils in Ihrem als Standard festgelegten Internetbrowser.

Im oberen Bereich der Seite befindet sich die Suchleiste. Dort können Sie Ihre Suchbegriffe einge-
ben. Schon bei der Eingabe eines Buchstabens bekommen Sie direkt darunter eine Auswahl von 
Themen. Mit jedem weiteren Buchstaben konkretisiert sich die Auswahl.

KLICKEN Sie dann in die Auswahl auf ein Thema, um die Beschreibung dazu im mittleren Bereich 
des Fensters zu lesen.

Noch Fragen?

Für Fragen zum Thema gehen Sie zu Ask.LibreOffice:

Fragen auf ask.LibreOffice

Mitarbeit bei LibreOffice

Besuchen Sie uns auch auf der Seite Dabei sein!:

LibreOffice Community

Spenden

LibreOffice ist freie Software und wird kostenfrei zur Verfügung gestellt. Ihre Spende, die rein 
freiwillig ist, unterstützt unsere weltweite Gemeinschaft. Wenn Ihnen die Software gefällt, freuen 
wir uns über eine Spende auf Spenden für die Document Foundation.
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